Every conceivable measure has been taken to ensure the accuracy and completeness of this documentation. However, as errors can never be fully excluded, we always appreciate any information or suggestions for improving the documentation.

E-Mail: documentation@wago.com

We wish to point out that the software and hardware terms as well as the trademarks of companies used and/or mentioned in the present manual are generally protected by trademark or patent.
## Table of Contents

1. **Notes about this Documentation**................................................................. 5  
1.1 Validity of this Documentation................................................................. 5  
1.2 Copyright................................................................................................... 5  
1.3 Symbols..................................................................................................... 6  
1.4 Number Notation....................................................................................... 8  
1.5 Font Conventions ...................................................................................... 8  
2. **Important Notes** ........................................................................................... 9  
2.1 Legal Bases ............................................................................................... 9  
2.1.1 Subject to Changes............................................................................... 9  
2.1.2 Personnel Qualifications....................................................................... 9  
2.1.3 Use of the 750 Series in Compliance with Underlying Provisions ....... 9  
2.1.4 Technical Condition of Specified Devices ......................................... 10  
2.2 Safety Advice (Precautions) .................................................................... 11  
3. **Quickstart Description** .............................................................................. 13  
3.1 Hardware Design..................................................................................... 13  
3.1.1 Electric Connection............................................................................ 13  
3.1.2 View PLC ETHERNET 750-880 and its Connection ....................... 14  
3.1.3 View PLC ETHERNET 750-881 and its Connection ....................... 16  
3.1.4 View PLC ETHERNET 750-882 and its Connection ....................... 18  
3.1.5 Operating Mode Switch...................................................................... 20  
3.2 Preparatory Measures .............................................................................. 21  
3.2.1 Installing WAGO-I/O-PRO ................................................................ 21  
3.2.2 Starting Up the Ethernet Network ................................................... 26  
3.2.2.1 Determining the IP address of your PC and changing it if required 27  
3.2.2.2 Assigning an IP address to the SPS ............................................... 28  
3.2.2.3 Testing the ETHERNET Link ....................................................... 31  
3.2.3 Installing the USB Driver ................................................................... 32  
3.3 The First Program ................................................................................... 34  
3.3.1 Create New Project............................................................................. 34  
3.3.2 Select Target System .......................................................................... 34  
3.3.3 Create PLC_PRG Module .................................................................. 36  
3.3.4 Configure Hardware ........................................................................... 36  
3.3.5 Write Application ............................................................................... 41  
3.3.6 Commissioning................................................................................... 47  
3.3.6.1 Configuring a Communication Driver for an ETHERNET Link .. 47  
3.3.6.2 Configuring a Communication Driver for a USB Link ................. 49  
3.3.7 Loading and Starting the Program...................................................... 52  
3.3.8 Visualization....................................................................................... 52  
3.3.8.1 Create Visualization....................................................................... 53  
3.3.8.2 Web Visualization ......................................................................... 62  
3.4 Memory Card (750-880) for Memory Expansion................................... 64  
3.4.1 Memory Card Slot ............................................................................. 65  
3.4.1.1 Inserting a Memory Card ............................................................... 66  
3.4.1.2 Removing the Memory Card.......................................................... 66  
3.4.2 Access to the SD Card via FTP Client .................................................. 67
4 Fieldbus Protocols Supported ................................................................. 69
List of Figures .......................................................................................... 70
List of Tables .......................................................................................... 72
1 Notes about this Documentation

1.1 Validity of this Documentation

This documentation is only applicable to the 750-880, -881, -882 ETHERNET Programmable Fieldbus of the WAGO-I/O-SYSTEM 750 series.

1.2 Copyright

This Manual, including all figures and illustrations, is copyright-protected. Any further use of this Manual by third parties that violate pertinent copyright provisions is prohibited. Reproduction, translation, electronic and phototechnical filing/archiving (e.g., photocopying) as well as any amendments require the written consent of WAGO Kontakttechnik GmbH & Co. KG, Minden, Germany. Non-observance will involve the right to assert damage claims.
### Symbols

#### DANGER

**Personal Injury!**
Indicates a high-risk, imminently hazardous situation which, if not avoided, will result in death or serious injury.

#### DANGER

**Personal Injury Caused by Electric Current!**
Indicates a high-risk, imminently hazardous situation which, if not avoided, will result in death or serious injury.

#### WARNING

**Personal Injury!**
Indicates a moderate-risk, potentially hazardous situation which, if not avoided, could result in death or serious injury.

#### CAUTION

**Personal Injury!**
Indicates a low-risk, potentially hazardous situation which, if not avoided, may result in minor or moderate injury.

#### NOTICE

**Damage to Property!**
Indicates a potentially hazardous situation which, if not avoided, may result in damage to property.

#### NOTICE

**Damage to Property Caused by Electrostatic Discharge (ESD)!**
Indicates a potentially hazardous situation which, if not avoided, may result in damage to property.

**Note**

**Important Note!**
Indicates a potential malfunction which, if not avoided, however, will not result in damage to property.
Information

Additional Information:
Refers to additional information which is not an integral part of this documentation (e.g., the Internet).
1.4 **Number Notation**

Table 1: Number Notation

<table>
<thead>
<tr>
<th>Number code</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>100</td>
<td>Normal notation</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0x64</td>
<td>C notation</td>
</tr>
<tr>
<td>Binary</td>
<td>'100'</td>
<td>In quotation marks, nibble separated with dotes (.)</td>
</tr>
<tr>
<td></td>
<td>'0110.0100'</td>
<td></td>
</tr>
</tbody>
</table>

1.5 **Font Conventions**

Table 2: Font Conventions

<table>
<thead>
<tr>
<th>Font type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>italic</em></td>
<td>Names of paths and data files are marked in italic-type. e.g.: <em>C:\Programme\WAGO-I/O-CHECK</em></td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td>Menu items are marked in bold letters. e.g.: <strong>Save</strong></td>
</tr>
<tr>
<td>&gt;</td>
<td>A greater-than sign between two names means the selection of a menu item from a menu. e.g.: File &gt; New</td>
</tr>
<tr>
<td><strong>Input</strong></td>
<td>Designation of input or optional fields are marked in bold letters. e.g.: <strong>Start of measurement range</strong></td>
</tr>
<tr>
<td>“Value”</td>
<td>Input or selective values are marked in inverted commas. e.g.: Enter the value “4 mA” under <strong>Start of measurement range</strong></td>
</tr>
<tr>
<td>[Button]</td>
<td>Pushbuttons in dialog boxes are marked with bold letters in square brackets. e.g.: [Input]</td>
</tr>
<tr>
<td>[Key]</td>
<td>Keys are marked with bold letters in square brackets. e.g.: [F5]</td>
</tr>
</tbody>
</table>
2 Important Notes

This section includes an overall summary of the most important safety requirements and notes that are mentioned in each individual section. To protect your health and prevent damage to devices as well, it is imperative to read and carefully follow the safety guidelines.

2.1 Legal Bases

2.1.1 Subject to Changes

WAGO Kontakttechnik GmbH & Co. KG reserves the right to provide for any alterations or modifications that serve to increase the efficiency of technical progress. WAGO Kontakttechnik GmbH & Co. KG owns all rights arising from the granting of patents or from the legal protection of utility patents. Third-party products are always mentioned without any reference to patent rights. Thus, the existence of such rights cannot be excluded.

2.1.2 Personnel Qualifications

All sequences implemented on Series 750 devices may only be carried out by electrical specialists with sufficient knowledge in automation. The specialists must be familiar with the current norms and guidelines for the devices and automated environments.

All changes to the coupler or controller should always be carried out by qualified personnel with sufficient skills in PLC programming.

2.1.3 Use of the 750 Series in Compliance with Underlying Provisions

Couplers, controllers and I/O modules found in the modular WAGO-I/O-SYSTEM 750 receive digital and analog signals from sensors and transmit them to the actuators or higher-level control systems. Using programmable controllers, the signals can also be (pre-) processed.

The components have been developed for use in an environment that meets the IP20 protection class criteria. Protection against finger injury and solid impurities up to 12.5 mm diameter is assured; protection against water damage is not ensured. Unless otherwise specified, operation of the components in wet and dusty environments is prohibited.

Operating 750 Series components in home applications without further measures is only permitted if they meet the emission limits (emissions of interference) according to EN 61000-6-3. You will find the relevant information in the section on "WAGO-I/O-SYSTEM 750" → "System Description" → "Technical Data" in the manual for the used fieldbus coupler/controller.
Appropriate housing (per 94/9/EG) is required when operating the WAGO-I/O-SYSTEM 750 in hazardous environments. Please note that a prototype test certificate must be obtained that confirms the correct installation of the system in a housing or switch cabinet.

2.1.4 Technical Condition of Specified Devices

The components to be supplied Ex Works, are equipped with hardware and software configurations, which meet the individual application requirements. WAGO Kontakttechnik GmbH & Co. KG will be exempted from any liability in case of changes in hardware or software as well as to non-compliant usage of components.

Please send your request for modified and new hardware or software configurations directly to WAGO Kontakttechnik GmbH & Co. KG.
2.2 Safety Advice (Precautions)

For installing and operating purposes of the relevant device to your system the following safety precautions shall be observed:

---

**DANGER**

Do not work on components while energized!
All power sources to the device shall be switched off prior to performing any installation, repair or maintenance work.

---

**DANGER**

Installation only in appropriate housings, cabinets or in electrical operation rooms!
The WAGO-I/O-SYSTEM 750 and its components are an open system. As such, install the system and its components exclusively in appropriate housings, cabinets or in electrical operation rooms. Allow access to such equipment and fixtures to authorized, qualified staff only by means of specific keys or tools.

---

**NOTICE**

Replace defective or damaged devices!
Replace defective or damaged device/module (e.g., in the event of deformed contacts), since the long-term functionality of device/module involved can no longer be ensured.

---

**NOTICE**

Protect the components against materials having seeping and insulating properties!
The components are not resistant to materials having seeping and insulating properties such as: aerosols, silicones and triglycerides (found in some hand creams). If you cannot exclude that such materials will appear in the component environment, then install the components in an enclosure being resistant to the above-mentioned materials. Clean tools and materials are imperative for handling devices/modules.

---

**NOTICE**

Cleaning only with permitted materials!
Clean soiled contacts using oil-free compressed air or with ethyl alcohol and leather cloths.
**NOTICE**

Do not use any contact spray!
Do not use any contact spray. The spray may impair contact area functionality in connection with contamination.

**NOTICE**

Do not reverse the polarity of connection lines!
Avoid reverse polarity of data and power supply lines, as this may damage the devices involved.

**NOTICE**

Avoid electrostatic discharge!
The devices are equipped with electronic components that you may destroy by electrostatic discharge when you touch. Pay attention while handling the devices to good grounding of the environment (persons, job and packing).
3  Quickstart Description

3.1  Hardware Design

The fieldbus node is to be installed as follows (viewed from left to right):

Table 3: Hardware Design

<table>
<thead>
<tr>
<th>Position</th>
<th>I/O Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PLC ETHERNET</td>
</tr>
<tr>
<td></td>
<td>750-880 or</td>
</tr>
<tr>
<td></td>
<td>750-881 or</td>
</tr>
<tr>
<td></td>
<td>750-882</td>
</tr>
<tr>
<td>2</td>
<td>Digital Input Module</td>
</tr>
<tr>
<td>3</td>
<td>Digital Output Module</td>
</tr>
<tr>
<td>4</td>
<td>End Module</td>
</tr>
</tbody>
</table>

|          | 750-400                  |
|          | 750-501                  |
|          | 750-600                  |

Note

Hardware must include end module 750-600 and an I/O module!
Please note that your hardware setup must include at least one I/O module and end module 750-600 behind the PLC to ensure the function of the internal data bus.

3.1.1  Electric Connection

The 24V DC power supply unit is linked to the 24V and 0V power for the PLC and for the power jumper contacts (see No. 5 in the figures below “View PLC ETHERNET and its 24 V/0 V Connection”).

For the application used in the example, it is sufficient to connect a jumper between "24V" and "+" (see No. 6) or between "0V" and "-" (see No. 9).
3.1.2 View PLC ETHERNET 750-880 and its Connection

Figure 1: View PLC ETHERNET 750-880 and its 24 V/0 V Connection
### Table 4: Legend to the View ETHERNET TCP/IP Fieldbus Controller

<table>
<thead>
<tr>
<th>No.</th>
<th>Designation</th>
<th>Meaning</th>
<th>Details see Chapter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LINK ACT 1, 2, MS, NS, I/O, USR</td>
<td>Status LEDs Fieldbus</td>
<td>&quot;Device Description&quot; &gt; &quot;Display Elements&quot;</td>
</tr>
<tr>
<td>2</td>
<td>---</td>
<td>Group marking carrier (retractable) with additional marking possibility on two miniature WSB markers</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>A, B or C</td>
<td>Status LED’s System/Field Supply</td>
<td>&quot;Device Description&quot; &gt; &quot;Display Elements&quot;</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Data Contacts</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Data Contacts/Internal Bus&quot;</td>
</tr>
<tr>
<td>5</td>
<td>24 V, 0 V</td>
<td>CAGE CLAMP® Connections System Supply</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>6</td>
<td>+</td>
<td>CAGE CLAMP® Connections Field Supply DC 24 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>7</td>
<td>---</td>
<td>Power Jumper Contact 24 V DC</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>8</td>
<td>---</td>
<td>Unlocking Lug</td>
<td>&quot;Assembly&quot; &gt; &quot;Inserting and Removing Devices&quot;</td>
</tr>
<tr>
<td>9</td>
<td>-</td>
<td>CAGE CLAMP® Connections Field Supply 0 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Power Jumper Contact 0 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>11</td>
<td>(Earth)</td>
<td>CAGE CLAMP® Connections Field Supply (Earth)</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>12</td>
<td>---</td>
<td>Power Jumper Contact (Earth)</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>13</td>
<td>---</td>
<td>Service Interface (open flap)</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
<tr>
<td>14</td>
<td>X1, X2</td>
<td>Fieldbus connection 2 x RJ-45 as 2-Port ETHERNET Switch</td>
<td>&quot;Device Description&quot; &gt; &quot;Connectors&quot;</td>
</tr>
<tr>
<td>15</td>
<td>---</td>
<td>SD card slot with cover lid</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
<tr>
<td>16</td>
<td>---</td>
<td>Locking Disc</td>
<td>&quot;Assembly&quot; &gt; &quot;Inserting and Removing Devices&quot;</td>
</tr>
<tr>
<td>17</td>
<td>---</td>
<td>Address Selection Switch</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
</tbody>
</table>
3.1.3 View PLC ETHERNET 750-881 and its Connection

Figure 2: View PLC ETHERNET 750-881 and its 24 V/0 V Connection
Table 5: Legend to the View ETHERNET TCP/IP Fieldbus Controller

<table>
<thead>
<tr>
<th>No.</th>
<th>Designation</th>
<th>Meaning</th>
<th>Details see Chapter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LINK ACT 1, 2, MS, NS, I/O, USR</td>
<td>Status LEDs Fieldbus</td>
<td>&quot;Device Description&quot; &gt; &quot;Display Elements&quot;</td>
</tr>
<tr>
<td>2</td>
<td>---</td>
<td>Group marking carrier (retractable) with additional marking possibility on two miniature WSB markers</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>A, B or C</td>
<td>Status LED’s System/Field Supply</td>
<td>&quot;Device Description&quot; &gt; &quot;Display Elements&quot;</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Data Contacts</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Data Contacts/Internal Bus&quot;</td>
</tr>
<tr>
<td>5</td>
<td>24 V, 0 V</td>
<td>CAGE CLAMP® Connections System Supply</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>6</td>
<td>+</td>
<td>CAGE CLAMP® Connections Field Supply DC 24 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>7</td>
<td>---</td>
<td>Power Jumper Contact 24 V DC</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>8</td>
<td>---</td>
<td>Unlocking Lug</td>
<td>&quot;Assembly&quot; &gt; &quot;Inserting and Removing Devices&quot;</td>
</tr>
<tr>
<td>9</td>
<td>-</td>
<td>CAGE CLAMP® Connections Field Supply 0 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Power Jumper Contact 0 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>11</td>
<td>(Earth)</td>
<td>CAGE CLAMP® Connections Field Supply (Earth)</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>12</td>
<td>---</td>
<td>Power Jumper Contact (Earth)</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>13</td>
<td>---</td>
<td>Service Interface (open flap)</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
<tr>
<td>14</td>
<td>X1, X2</td>
<td>Fieldbus connection 2 x RJ-45 as 2-Port ETHERNET Switch</td>
<td>&quot;Device Description&quot; &gt; &quot;Connectors&quot;</td>
</tr>
<tr>
<td>15</td>
<td>---</td>
<td>Locking Disc</td>
<td>&quot;Assembly&quot; &gt; &quot;Inserting and Removing Devices&quot;</td>
</tr>
<tr>
<td>16</td>
<td>---</td>
<td>Address Selection Switch</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
</tbody>
</table>
3.1.4 View PLC ETHERNET 750-882 and its Connection

Figure 3: View PLC ETHERNET 750-882 and its 24 V/0 V Connection
Table 6: Legend to the View ETHERNET TCP/IP Fieldbus Controller

<table>
<thead>
<tr>
<th>No.</th>
<th>Designation</th>
<th>Meaning</th>
<th>Details see Chapter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LINK ACT 1, 2, MS, NS, I/O, USR</td>
<td>Status LEDs Fieldbus</td>
<td>&quot;Device Description&quot; &gt; &quot;Display Elements&quot;</td>
</tr>
<tr>
<td>2</td>
<td>---</td>
<td>Group marking carrier (retractable) with additional marking possibility on two miniature WSB markers</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>A, B or C</td>
<td>Status LED’s System/Field Supply</td>
<td>&quot;Device Description&quot; &gt; &quot;Display Elements&quot;</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Data Contacts</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Data Contacts/Internal Bus&quot;</td>
</tr>
<tr>
<td>5</td>
<td>24 V, 0 V</td>
<td>CAGE CLAMP® Connections System Supply</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>6</td>
<td>+</td>
<td>CAGE CLAMP® Connections Field Supply DC 24 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>7</td>
<td>---</td>
<td>Power Jumper Contact 24 V DC</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>8</td>
<td>---</td>
<td>Unlocking Lug</td>
<td>&quot;Assembly&quot; &gt; &quot;Inserting and Removing Devices&quot;</td>
</tr>
<tr>
<td>9</td>
<td>-</td>
<td>CAGE CLAMP® Connections Field Supply 0 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Power Jumper Contact 0 V</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>11</td>
<td>(Earth)</td>
<td>CAGE CLAMP® Connections Field Supply (Earth)</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Connecting a conductor to the CAGE CLAMP®&quot;</td>
</tr>
<tr>
<td>12</td>
<td>---</td>
<td>Power Jumper Contact (Earth)</td>
<td>&quot;Connect Devices&quot; &gt; &quot;Power Contacts/Field Supply&quot;</td>
</tr>
<tr>
<td>13</td>
<td>---</td>
<td>Service Interface (open flap)</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
<tr>
<td>14</td>
<td>X1, X2</td>
<td>Fieldbus connection 2 x RJ-45 (2 independent Ethernet interfaces)</td>
<td>&quot;Device Description&quot; &gt; &quot;Connectors&quot;</td>
</tr>
<tr>
<td>15</td>
<td>---</td>
<td>Locking Disc</td>
<td>&quot;Assembly&quot; &gt; &quot;Inserting and Removing Devices&quot;</td>
</tr>
<tr>
<td>16</td>
<td>---</td>
<td>Address Selection Switch</td>
<td>&quot;Device Description&quot; &gt; &quot;Operating Elements&quot;</td>
</tr>
</tbody>
</table>
3.1.5 Operating Mode Switch

**Note**

Set the operating mode switch to the top position!
Set the operating mode switch to the top position. At this setting, the firmware and application program are executed (Activate program execution / "RUN").

The mode selector switch is located behind the cover flap (see No. 13 in the Figure above).

![Mode selector switch](image)

Figure 4: Mode selector switch (closed and open damper of the service port)

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the damper</td>
</tr>
<tr>
<td>2</td>
<td>Operating mode switch</td>
</tr>
</tbody>
</table>
3.2 Preparatory Measures

3.2.1 Installing WAGO-I/O-PRO

WAGO-I/O-PRO is a programming and visualization tool for PLC programs. This software is used to develop PLC applications for WAGO-I/O SYSTEM 750 PLCs.

WAGO-I/O-PRO runs in line with the IEC 61131-3 standard, which specifies the requirements for a programming system.

You can use this programming tool to develop application programs in the programming languages AWL, KOP, FUP, CFC, ST and AS.

Proceed as follows to perform the installation:

1. Place the WAGO-I/O-PRO CD into your CD drive.
2. If the installation does not begin automatically, start the file Setup.exe.

![Figure 5: Contents of the WAGO-I/O-PRO CD (folder view), file Setup.exe](image)
3. Select the language and confirm it by clicking the button [OK].

![Selecting the setup language](image)

Figure 6: Selecting the setup language

4. Start the Setup using the InstallShield Wizard by clicking the button [Next >].

![Starting the setup](image)

Figure 3: Starting the setup
5. Accept the license agreement by clicking the button [Yes].

![License Agreement](Image)

Figure 7: License agreement

6. Select the target directory and confirm it by clicking the button [Next].

![Selecting the target directory](Image)

Figure 8: Selecting the target directory
7. Select the components to be installed and confirm it by clicking the button [Next].

Figure 9: Selection of components

8. Select the program folder and confirm it by clicking the button [Next].

Figure 10: Selection of program folder
9. Check the settings you have defined and confirm it by clicking the button [Next].

Figure 11: Overview of configuration

The pdf document „EA_ConfigurationReleaseInfo.pdf“ with information about the new version of the WAGO-IO-Configuration dialogue is opened.

Figure 12: pdf file „EA_ConfigurationReleaseInfo.pdf“
10. Complete the CoDeSys setup by clicking the button [Finish].

Figure 13: Completing the setup

3.2.2 Starting Up the Ethernet Network

This section provides you with a step-by-step sample procedure for starting up the ETHERNET network.

You must perform three steps to start up the network:

- **Determine the IP address of your PC and change it if required**
- **Assign an IP address to the SPS**
- **Test the ETHERNET link**

The description of these work steps can be found in the corresponding following sections.

---

**Good example!**

This description is just an example and only describes the procedure for local startup of a single SPS using a non-networked computer under the Windows system.
3.2.2.1 Determining the IP address of your PC and changing it if required

The explanation below describes how you can determine the IP address currently set for your PC and how you can change it if required.

1. To set up an ETHERNET link connect the ETHERNET port of your PC to one of the two ETHERNET ports of the SPS using the cross-over cable provided with the system.

2. You can determine the IP address of your PC under: Start > Settings > Networks > LAN. Here, right click on the option PROPERTIES for the network you are currently using (LAN X).

3. Then mark the item "Internet Protocol (TCP/IP)" in the popup list and confirm by clicking [PROPERTIES].

Figure 14: Properties of your LAN network link
4. Check whether the current IP address is set within the address range **192.168.1.1** to **192.168.1.254**. If not, change it accordingly.

![Properties of the TCP/IP Internet protocol](image)

Figure 15: Properties of the TCP/IP Internet protocol

### 3.2.2.2 Assigning an IP address to the SPS

#### Note

**The IP address must occur in the network only once!**
To ensure error-free network communication the IP addresses assigned to the PC and to the SPS must be unique within the network! In the event of an error, the error message "IP address configuration error" (error code 6 - error argument 6) is indicated by the I/O LED at the next SPS power-on.

You can also use the address selection switch (DIP switch), Web-based Management, DHCP, BootP or WAGO ETHERNET-Settings to assign an IP address to the SPS.

The option using the address selection switch is described in this QuickStart Guide. The other options are not described here, as these are explained separately in the respective manuals for the „750-880 ETHERNET Programmable Fieldbus..."
Use the address selection switch to set the host ID, i.e., the last byte of the IP address, binary encoded in the range between 1 and 254.

The network address consists of the first three bytes of the IP address; the factory default settings are:

- 750-880: **192.168.1.**
- 750-881: **192.168.1.**
- 750-882: **192.168.1.** (Port1) or. **192.168.2.** (Port2)

You can change this network address in the Web-based Management system under menu item **TCP/IP** in the dialog input field "Switch IP address."

Table 8: IP Address Structure

<table>
<thead>
<tr>
<th>Network Address</th>
<th>Host ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>192 . 168 . 1 .</td>
<td>100</td>
</tr>
</tbody>
</table>

The IP address statically set previously by Web-based Management will be overwritten with the address assigned by the address selection switch.

---

### Note

**Address selection switch values 0 and 255 are permanent default settings!**

If you use the address selection switch to set a value of 0 or 255, this will activate the IP modes for these values. When a value of 0 is set, the IP configurations executed by Web-based management will apply. Setting a value of 255 will activate address allocation by DHCP.

1. To assign a value (except for 0/255) for the host ID using the address selection switch you must first convert the host ID value to a binary numeral.

In the configuration example shown here the host ID 100 is used for the SPS. The decimal value of "100" converts to a binary code of "01100100."

Table 9: Binary Encoding of Decimal Number 100

<table>
<thead>
<tr>
<th>MSB</th>
<th>LSB</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
2. Set the bits in order using the 8 DIP switches. Begin with DIP switch 1 to set Bit 0 (LSB) and continue up to DIP switch 8 for Bit 7 (MSB).

![Figure 16: Address selection switch with set IP address (192.168.1.100)](image)

3. Restart the SPS after adjusting the address selection switch to apply the IP configuration changes.
   To do this, open the cover for the service interface and press the mode switch down (e.g., using an actuation tool, Item No.: 210-720).

![Figure 17: Restarting the SPS via hardware reset](image)
3.2.2.3 Testing the ETHERNET Link

1. To test the ETHERNET link open the command line interpreter by entering "cmd" at Start > Execute... under Windows.

![Command line interpreter with ping command](image1.png)

Figure 18: "Execute ...." dialog window

2. Enter the command "ping 192.168.1.100."

![Command line interpreter with ping statistics](image2.png)

When the ETHERNET link is error free you will receive the following ping statistics: "Packets: Sent=4, Received=4, Lost=0 (0% loss)."

![Command line interpreter with ping statistics](image3.png)

Figure 20: Command line interpreter with ping statistics
3.2.3 Installing the USB Driver

The "WAGO USB Service Cable" (Item No.: 750-923) provides easy communication with the WAGO software tools (WAGO-ETHERNET-Settings, WAGO-I/O-CHECK 3, etc.) and with the IEC-61131 programming topology (WAGO-I/O-PRO).

Proceed as follows to install the USB driver:

1. Start the network browser and open the web page [www.wago.com](http://www.wago.com). You can download the USB Driver under: Service → Downloads → AUTOMATION → WAGO-I/O-SYSTEM 750/753 → 759-923.

2. Change into your download file, open the archive file 750-923.zip and execute the file Setup.exe, accordingly for your operating system in the file WIN2K_XP_VISTA_WIN7 or WIN98.

![Figure 21: Installing the USB Driver](image-url)
3. Select the installation directory and start the setup by clicking the button [Install].

![Figure 22: Selecting the target directory](image)

4. As soon as the installation completed successfully, finish the Setup by clicking the button [OK].

![Figure 23: Finishing the installation of the USB Driver](image)
3.3 The First Program

**Note**

Preparatory measures are required!
Please note that the steps described below require that the preparatory measures cited previously have all been successfully performed. It is imperative that you have installed the WAGO-I/O-PRO software and the USB cable driver, and that there is a network connection between the PLC and PC.

3.3.1 Create New Project

1. Launch the WAGO-I/O-PRO development environment.
2. From the **File > New** menu, create a new project.

3.3.2 Select Target System

1. First select the PLC from the drop-down list for the target system settings.

![Figure 24: PLC drop-down list](image)
2. Click [OK] to confirm your target system settings.

![Image of Target Settings dialog]

Figure 25: Confirm target system settings (example: WAGO_750-881)

The "New Module" dialog appears.

3. If you want to change the target system of your project later, select the **Target System Settings** on the **Resources** tab.

![Image of Project Management window]

Figure 26: Change the target system under: Target System Settings on the Resources tab.
3.3.3 Create PLC_PRG Module

If you want to create an initial module in a new project, the module automatically receives the name "PLC_PRG". Execution starts from there and you can also call other modules from there (programs, function blocks, and functions).

Initially, PLC_PRG is the only module!
Please note that until you have created a task configuration, PLC_PRG is the only module that is called up and executed cyclically by the runtime system during operation. This module is called up and executed exactly once per control cycle.

1. In the New Module dialog, select the Module Language "FUP" (function plan) and keep the settings Module Type "Program" and Module Name "PLC_PRG".

2. Click [OK] to confirm your settings.

3.3.4 Configure Hardware

Configure the hardware, before you actually begin creating the program module.

In the sample project, the hardware setup consists of the following components:

- PLC ETHERNET 750-881
- 2-channel digital input module 750-400
- 2-channel digital output module 750-501
- End module SPS ETHERNET 750-600
1. For the hardware configuration, double-click **PLC Configuration** on the **Resources** tab.

![Image of PLC Configuration window](image1.png)

Figure 28: Configure the hardware under **Resources** tab, **PLC Configuration**

The "PLC Configuration" dialog appears.

2. In the "PLC Configuration" dialog, select **K-Bus**\(^1\) in the tree structure.

3. Then right-click to open the context menu and select the **Add sub-module** menu item.

![Image of Add sub-module menu item](image2.png)

Figure 29: "PLC Configuration" dialog – **Add sub-module** menu item

The "I/O Configurator" dialog appears.

\(^1\) *K-Bus = internal data bus*
4. Click on the [+] button in the "I/O Configurator" dialog. The "Selected Modules" dialog appears.

![Figure 30: "Configuration" dialog Inputs/Outputs, button [+]](image1.png)

5. In the left window, select the I/O modules based on your hardware setup and click on the [Insert >>] button to add them.

![Figure 31: "Selected Modules" dialog](image2.png)
The end module is not specified!
Please note that the 750-600 end module is not specified when configuring the PLC.

6. Click [OK] to close the "Selected Modules" dialog.

7. Then assign variables to the digital input/output modules in the right window of the I/O Configurator.

Figure 32: "Configuration" dialog, Inputs/Outputs tab, assign global variables
Make the following declarations in this sample project:

Table 10: Digital input module 750-400

<table>
<thead>
<tr>
<th>Channel</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DI 1</td>
</tr>
<tr>
<td>2</td>
<td>DI2</td>
</tr>
</tbody>
</table>

Table 11: Digital output module 750-501

<table>
<thead>
<tr>
<th>Channel</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DO1</td>
</tr>
<tr>
<td>2</td>
<td>DO2</td>
</tr>
</tbody>
</table>

**Note**

Global variable declaration!
Please note that the variables declared in the I/O configurator are known as global variables throughout the project.

8. Click [OK] to close the "Configuration" dialog.
3.3.5 Write Application

In the sample project, the application consists of a simple control of the first channel (DO1) of the digital output module. It is controlled depending on the states of both channels (DI1 and DI2) of the digital input module. A function block with RS logic (reset dominant) is used.

1. Select the Modules tab.
2. Double-click on the PLC_PRG module to open the program block window.

![Figure 33: Modules tab, PLC_PRG (PRG) module](image)

3. In the program module window, click on the small square behind the three question marks ??? to highlight it.
4. Then right-click to display the context menu.
5. Select the Box menu item.

An AND module is created by default.

![Figure 34: PLC_PRG program module window, Module context menu item](image)
6. Replace it with the required module by pressing <F2> to open the Input Assistant.
   A dialog appears in which you can select the required module from the available modules.

![Input Assistant, select standard function blocks](image)

Figure 35: Input Assistant, select standard function blocks

7. In the left window, select the **Standard Function Blocks** category for this example, and in the right window, select the bistable function block **RS (FB)** from the *Standard.lib* library.

8. Create an instance (data copy) from the **RS (FB)** module.
9. Select the three question marks ??? above the inserted module, write the instance name "rsDO1" instead, and left-click behind the function block. The Variable Declaration dialog appears in which the VAR class (for local variables), name rsDO1, and type RS are already entered.

![Variable Declaration dialog](image)

Figure 36: Variable Declaration dialog

10. If you want, add a comment and click [OK] to close the dialog. The instance is now entered in the declaration part of the module.
11. Select the three question marks ??? located on the inserted SET block input.

12. Press <F2> to open the Input Assistant. The Input Assistant appears.

13. In the left window, select the Global Variable category, and in the right window, the D1 (BOOL) variable.

Figure 37: Global variables
14. Select the three question marks ??? located on the inserted **RESET1** block input.

15. Press <F2> to open the Input Assistant. The **Input Assistant** appears.

16. In the left window, select the **Global Variable** category, and in the right window, the **D2 (BOOL)** variable.

17. In the program module window, click on the small square on the **Q1** output of the function block to highlight it.

18. Then right-click to display the context menu.

![Figure 38: Function block assignment](image)
19. Now select the **Assignment** menu item and assign the global variable **DO1 (BOOL)** in the same way to the output of the function block.

![Figure 39: Function block assignment DO1](image)
3.3.6 Commissioning

This chapter describes step-by-step how to load your previously created WAGO I/O-PRO project into your PLC, how to start program execution, and how to create a boot project.

3.3.6.1 Configuring a Communication Driver for an ETHERNET Link

1. To set up the communication driver for the ETHERNET connection, click on the Communication Parameters... menu item in the WAGO-I/O-PRO dialog under the Online menu.

![Communication driver](image)

Figure 40: Communication driver

The "Communication Parameters" dialog appears.
2. In the "Communication Parameters" dialog, click the [NEW...] button to create a new communication channel. The "Communication Parameters: New Channel" dialog appears.

![Figure 41: Communication Parameters, Create communication channel](image)

3. For an ETHERNET connection, assign a name to the communication channel you just created in the **Name** input box (here "ETHERNETConnection" as an example).

4. Then select the driver "Tcp/IP 3S Tcp/IP driver."

5. Click [OK] to confirm your entries.

![Figure 42: Communication Parameters, New channel](image)

6. Then double-click on the localhost address field in the **Value** column in the "Communication Parameters" dialog for this communication channel.

7. Enter the IP address of your PLC here (192.168.1.100). You can leave all other parameters (Port, Motorola byteorder, and the gateway settings) as they are.
8. Click [OK] to confirm your entries.

![Communication Parameters, IP address](image)

**Figure 43: Communication Parameters, IP address**

### 3.3.6.2 Configuring a Communication Driver for a USB Link

1. Connect the USB cable (750-923) to a USB port of your PC.

2. Under Windows, you can check which COM port of your PC has been assigned to the USB cable at: **Start > Settings > Control panel > System.**
   The "System Properties" dialog appears.

3. Here, select the tab **Hardware** and click the button **[Device manager]** to open the dialog window for the device manager.
4. Add the group **Ports (COM and LPT)** to the tree structure. The entry **WAGO USB Service Cable (COMX)** (the designation in parentheses indicates the assigned COM port; in this example COM27) is given within this group.

![WAGO USB service cable (COMX)](image)

Figure 44: WAGO USB service cable (COMX)

5. To set up the communication driver for the USB connection, click on the **Communication Parameters**... menu item in the WAGO-I/O-PRO dialog under the **Online** menu. The "Communication Parameters" dialog appears.

6. In the "Communication Parameters" dialog, click the **[NEW...]** button to create a new communication channel. The "Communication Parameters: New Channel" dialog appears.

![Communication Parameters: New Channel](image)

Figure 45: Driver (Serial RS-232 3S Serial RS-232 driver)

7. For a USB connection, assign a name to the communication channel you just created in the **Name** input box (here "USBConnection" as an example).
8. Then select the driver "Serial (RS-232) 3S Serial RS-232 driver".

9. Click \[ OK \] to confirm your entries.

10. Then double-click on the COM1 address field in the Value column in the "Communication Parameters" dialog for this communication channel, so that it is marked in gray.

![Communication Parameters, COM port](image)

11. Press the \[ ↓ \] or \[ ↑ \] arrow to increase or decrease the COM port number by one.
   Adjust the COM port previously identified in the Device Manager (in this example "COM27") in the Communication Parameters accordingly.
   You can leave all other parameters (Baudrate, Parity, Stop bits, Motorola byteorder, Flow Control) and the gateway settings as they are.

12. Click \[ OK \] to confirm your entries.
3.3.7 Loading and Starting the Program

1. To load the program into your PLC, click on the Login menu item in the WAGO-I/O-PRO dialog under the Online menu.

2. Then start program execution in the PLC via the menu item Online > Start.

3. Now select the menu item Online > Create bootproject to create a boot project. With this boot project, the program is automatically loaded when restarting the PLC.

4. To automatically start the PLC after restarting, move the Operating mode switch behind the cover cap of the service interface to the top position (RUN) on the PLC.

Figure 47: Operating mode switch at the top position (RUN)

3.3.8 Visualization

In this sample project, a visualization is created that displays the logical state of two digital inputs (DI1 and DI2) and two digital outputs (DO1 and DO2). In addition, it is possible to change the state of a digital output (here DO2) via a button in the visualization.

After you have loaded, and started the program created with the WAGO-I/O-PRO software, you can then display and operate the process via the visualization in two ways:

- You can control the process from the visualization in the WAGO-I/O-PRO software directly.
- You can also call up the process in an Internet browser as a Web visualization and control the process via this visualization.

The function and presentation are identical for both visualization options.
Note

The first program must be created!
Please note that the first program must be successfully created as previously described as a requirement for the steps below. It is imperative that you have created a WAGO-I/O-PRO project, selected a target system, created a PLC configuration with the I/O Configurator, created the described application in the PLC_PRG module, and configured a corresponding communication driver.

Note

A Java runtime environment must be installed for Web visualization via Internet browser!
Please note that a Java runtime environment must be installed on your PC for Web visualization via Internet browser.
You can download a Java runtime environment ("JRE") from the Internet free of charge at: http://java.com/de/download/index.jsp

3.3.8.1 Create Visualization

1. Select the Visualizations tab and select "Visualizations" in the dialog.

2. Right-click to open the context menu and select the Insert Object... menu item.

![Figure 48: Create visualization](image)

3. Assign a name for the new visualization (here "PLC_VISU").
The name of the visualization object must be "PLC_VISU"!
Please note that the name of the visualization object must be "PLC_VISU" when creating a Web visualization.
For a WAGO-I/O-PRO project with several visualization objects, the visualization object called "PLC_VISU" is always loaded first in the Internet browser.

4. Then select the Ellipse visualization element and draw a circle. Select the required starting point and move the cursor while holding down the left mouse button until the element has the required dimensions.

5. Select the element.

6. Right-click to open the context menu and select the Configure... menu item.

![Figure 49: Visualization Element, Configure... context menu item](image)

The "Configure element (#0)" dialog appears.
7. In the "Configure element (#0)" dialog, select the **Text** category in the left drop-down list and assign the label "DI1" to this visualization element.

![Figure 50: Visualization element DI1](image)

8. Then select the category **Colors**.

9. In the **Color** area on the right side, click the **[Inside]** button to open the color selection.

![Figure 51: Color category, Color area, open "Color" dialog](image)

The "Color" dialog appears.
10. Select dark green in the "Color" dialog.

![Figure 52: "Color" dialog, select dark green](image)

11. Click [OK] to confirm your selection.

12. In the **Alarm color** area on the right side, then click the [**Inside**] button to display the color selection.

![Figure 53: Color category, Color alarm area, open "Color" dialog](image)

The "Color" dialog appears again.

!["Color" dialog, select bright green]

14. Click [OK] to confirm your selection.

15. In the "Configure element (#0)" dialog, select the Variables category in the left drop-down list.

![Variables category, Change color]

16. Click in the Change color field on the right side.

17. Press <F2> to open the Input Assistant. The Input Assistant appears.
18. In the right window, select the **DI1 (BOOL)** variable.

19. Click **[OK]** to close the dialog. The **DI1** variable is now entered in the **Change color** field.

![Figure 56: Input Assistant, select global variables](image)

20. Then click **[OK]** to close the "Configure element (#0) dialog."

![Figure 57: Variables category, Change color assigned DI1](image)
21. Draw three more circles using the "Ellipse" visualization element, just as was described for the first circle.

![Figure 58: Draw three more visualization elements](image)

22. Then configure the visualization elements as follows:

<table>
<thead>
<tr>
<th>Table 12: Visualization element 2 - configuration settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Category:</strong></td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Colors</td>
</tr>
<tr>
<td>Colors</td>
</tr>
<tr>
<td>Variables</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 13: Visualization element 3 - configuration settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Category:</strong></td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Colors</td>
</tr>
<tr>
<td>Colors</td>
</tr>
<tr>
<td>Variables</td>
</tr>
</tbody>
</table>
### Table 14: Visualization element 4 - configuration settings

<table>
<thead>
<tr>
<th>Category</th>
<th>Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Content (text)</td>
<td>DO2</td>
</tr>
<tr>
<td>Colors</td>
<td>Color (inside)</td>
<td>Dark green:</td>
</tr>
<tr>
<td>Colors</td>
<td>Alarm color (inside)</td>
<td>Light green:</td>
</tr>
<tr>
<td>Variables</td>
<td>Variables (Change color)</td>
<td>DO2</td>
</tr>
<tr>
<td>Input</td>
<td>Input (toggle variable)</td>
<td>DO2</td>
</tr>
</tbody>
</table>

The following view then appears:

![Configured visualization elements](image)

23. To load the program into your PLC, click on the **Login** menu item in the WAGO-I/O-PRO dialog under the **Online** menu.

24. Then start program execution in the PLC via the menu item **Online > Start**.
Figure 60: Program running on the PLC
3.3.8.2 Web Visualization

**Note**

Log out to make changes to the target system settings!
Please note that you have to log out of the WAGO-I/O-PRO software to make changes to the target system settings. If you are still logged in on your PLC with the WAGO-I/O-PRO software, then click on the **Logout** menu item in the **Online** menu.

1. If you want to change the target system of your project, select the **Target System Settings** on the **Resources** tab.

![Figure 61: Change the target system under: Target System Settings on the Resources tab](image)

The "Target System Settings" dialog appears.
2. Select the **Visualization** tab in the "Target System Settings" dialog.

3. Activate the **Web Visualization** function in the Visualization tab.

4. Adjust the resolution of the Web visualization to the resolution of your monitor in the **Display width in pixels** and **Display height in pixels** fields.

![Figure 62: "Target System Settings" dialog, Activate web visualization](image)

5. Click [OK] to confirm your selection.
   The "Target System Settings" dialog closes.

6. Click the **Clean all** menu item in the WAGO-I/O-PRO dialog under the **Project** menu.

7. Then click the **Translate all** menu item in **Project** menu.

8. To load the program including the Web visualization into your PLC, click on the **Login** menu item in the WAGO-I/O-PRO dialog under the **Online** menu.

9. Then start program execution in the PLC via the menu item **Online > Start**.
10. To call up Web visualization from an Internet browser, enter the IP address for your fieldbus controller (192.168.1.100) in the URL line of your browser. An HTML page with the Web-based management system of your PLC appears.

11. Click the [WebVisu] button in the navigation column on the left. You can also call up Web visualization directly via http://192.168.1.100/plc/webvisu.htm.

The HTML page "WebVisu.htm" appears.

![HTML page WebVisu](image)

Figure 63: HTML page "WebVisu"

### 3.4 Memory Card (750-880) for Memory Expansion

The PLC ETHERNET 750-880 has the option of using a memory card to expand the memory. The memory card is optional and serves as additional memory for the internal memory of the PLC ETHERNET 750-880. The user program, user data, the source code of the project, or device settings can be saved to the memory card and thus already-existing project data and programs can be copied to one or more PLC's.
3.4.1 Memory Card Slot

The memory card slot accommodates a secure digital memory card (or SD card for short) or an SD card with a higher storage capacity (SD high capacity, or SDHC for short).

The memory card slot has a transparent protective flap that is folded upwards to open it.

---

**Note**

Memory card is not included in the scope of delivery!
Note, the fieldbus controller is delivered without memory card.
To use a memory card, you must order one separately. The fieldbus controller can also be operated without memory card expansion, the use of a memory card is optional.

---

**Note**

Only use recommended memory cards!
Use only the SD memory card available from WAGO (order no. 758-879/000-001) since it is suitable for industrial applications under difficult environmental conditions and for use in the fieldbus controller.
The compatibility to other storage media available in trade cannot be ensured.

---

**Information**

Additional information about the memory card
For technical information about the memory card, see the data sheet for the SD memory card (order no. 758-879/000-001).
The data sheet is on the Internet at: www.wago.com → Service → Documentation → WAGO-I/O-SYSTEM 758

---

Figure 64: Opening the memory card slot, inserting the SD card
3.4.1.1 Inserting a Memory Card

1. Use an activation tool or a screwdriver to open the transparent cover flap by folding it upwards.

2. Hold the memory card so that the contacts are visible on the left side and the sloping edge is towards the bottom, as depicted in the figure above.

3. Insert the memory card into the slot of the fieldbus controller.

4. Push the memory card all the way in. When you let go, the memory card will move back a little and then snap in.

5. Push the cover flap back in by folding it downwards until it snaps in.

3.4.1.2 Removing the Memory Card

1. Use an activation tool or a screwdriver to open the transparent cover flap by folding it upwards.

2. To remove the memory card, first press it into the slot. This loosens the mechanical locking

3. As soon as you let go of the memory card, the memory card is pushed out a bit and you can remove it.

4. Push the cover flap back in by folding it downwards until it snaps in.
3.4.2 Access to the SD Card via FTP Client

You need an FTP client such as "FileZilla" to access the SD card inserted in the PLC ETHERNET 750-880 via FTP protocol.

**Information**

Download "FileZilla" free of charge!
You can download "FileZilla" as an FTP client free of charge at http://filezilla-project.org/.

**Note**

FTP access via an Internet browser is not possible!
Please note that access to the SD card from an Internet browser via the FTP protocol is not possible.

1. After successfully downloading, launch "FileZilla".
2. Open the "Server Manager" from the File menu item.
3. Create a new server by clicking the [New Server] button.
4. Give the new server a name (here "750-880 SD Card").
5. Then configure the new server on the "General" tab as follows:

![Figure 65: "FileZilla" FTP client, Server Manager, "General" tab](image-url)
6. Then configure the new server on the "Advanced" tab as follows. Enter "s:\" as the default directory on the server.

Figure 66: "FileZilla" FTP client, Server Manager - "Advanced" tab

7. Then configure the new server on the "Transfer Settings" tab as follows. Enter "1" as the "Maximum number of connections".

Figure 67: "FileZilla" FTP client, Server Manager, "Transfer Settings" tab
8. Then click the [Connect] button to establish a connection to the SD card and to carry out the required access to the SD card.

## 4 Fieldbus Protocols Supported

Table 15: Fieldbus protocols supported by the PLC

<table>
<thead>
<tr>
<th>Protocol</th>
<th>750-880</th>
<th>750-881</th>
<th>750-882</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HTTP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>SNTP</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>DHCP</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>DNS</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BootP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modbus UDP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>ETHERNET-IP</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>Network Variables</td>
<td>X</td>
<td>X</td>
<td>-</td>
</tr>
</tbody>
</table>
List of Figures

Figure 1: View PLC ETHERNET 750-880 and its 24 V/0 V Connection........... 14
Figure 2: View PLC ETHERNET 750-881 and its 24 V/0 V Connection........... 16
Figure 3: View PLC ETHERNET 750-882 and its 24 V/0 V Connection........... 18
Figure 4: Mode selector switch (closed and open damper of the service port)..... 20
Figure 5: Contents of the WAGO-I/O-PRO CD (folder view), file Setup.exe....... 21
Figure 6: Selecting the setup language........................................................... 22
Figure 7: License agreement.......................................................................... 23
Figure 8: Selecting the target directory........................................................... 23
Figure 9: Selection of components.................................................................. 24
Figure 10: Selection of program folder............................................................ 24
Figure 11: Overview of configuration............................................................... 25
Figure 12: pdf file „EA_ConfigurationReleaseInfo.pdf“.................................. 25
Figure 13: Completing the setup...................................................................... 26
Figure 14: Properties of your LAN network link.............................................. 27
Figure 15: Properties of the TCP/IP Internet protocol...................................... 28
Figure 16: Address selection switch with set IP address (192.168.1.100)......... 30
Figure 17: Restarting the SPS via hardware reset............................................ 30
Figure 18: "Execute ...." dialog window........................................................... 31
Figure 19: Command line interpreter with ping command............................. 31
Figure 20: Command line interpreter with ping statistics............................... 31
Figure 21: Installing the USB Driver............................................................... 32
Figure 22: Selecting the target directory.......................................................... 33
Figure 23: Finishing the installation of the USB Driver................................. 33
Figure 24: PLC drop-down list........................................................................ 34
Figure 25: Confirm target system settings (example: WAGO_750-881).......... 35
Figure 26: Change the target system under: Target System Settings on the Resources tab................................................................. 35
Figure 27: "New Module" dialog..................................................................... 36
Figure 28: Configure the hardware under: Resources tab, PLC Configuration 37
Figure 29: "PLC Configuration" dialog – Add sub-module menu item............ 37
Figure 30: "Configuration" dialog Inputs/Outputs, button [+ ]....................... 38
Figure 31: "Selected Modules" dialog............................................................. 38
Figure 32: "Configuration" dialog, Inputs/Outputs tab, assign global variables 39
Figure 33: Modules tab, PLC_PRG (PRG) module ........................................ 41
Figure 34: PLC_PRG program module window, Module context menu item.... 41
Figure 35: Input Assistant, select standard function blocks........................... 42
Figure 36: Variable Declaration dialog............................................................. 43
Figure 37: Global variables............................................................................ 44
Figure 38: Function block assignment............................................................. 45
Figure 39: Function block assignment DO1................................................... 46
Figure 40: Communication driver................................................................. 47
Figure 41: Communication Parameters, Create communication channel...... 48
Figure 42: Communication Parameters, New channel..................................... 48
Figure 43: Communication Parameters, IP address....................................... 49
Figure 44: WAGO USB service cable (COMX).............................................. 50
Figure 45: Driver (Serial RS-232 3S Serial RS-232 driver)............................. 50
Figure 46: Communication Parameters, COM port....................................... 51
Figure 47: Operating mode switch at the top position (RUN)....................... 52
Figure 48: Create visualization................................................................. 53
Figure 49: Visualization Element, Configure... context menu item......... 54
Figure 50: Visualization element DI1 ..................................................... 55
Figure 51: Color category, Color area, open "Color" dialog ....................... 55
Figure 52: "Color" dialog, select dark green............................................. 56
Figure 53: Color category, Color alarm area, open "Color" dialog ............... 56
Figure 54: "Color" dialog, select bright green.......................................... 57
Figure 55: Variables category, Change color ........................................... 57
Figure 56: Input Assistant, select global variables.................................... 58
Figure 57: Variables category, Change color assigned DI1 ....................... 58
Figure 58: Draw three more visualization elements................................. 59
Figure 59: Configured visualization elements ....................................... 60
Figure 60: Program running on the PLC ............................................... 61
Figure 61: Change the target system under: Target System Settings on the
          Resources tab ............................................................................. 62
Figure 62: "Target System Settings" dialog, Activate web visualization .... 63
Figure 63: HTML page "WebVisu" ......................................................... 64
Figure 64: Opening the memory card slot, inserting the SD card............... 65
Figure 65: "FileZilla" FTP client, Server Manager, "General" tab ............... 67
Figure 66: "FileZilla" FTP client, Server Manager - "Advanced" tab .......... 68
Figure 67: "FileZilla" FTP client, Server Manager, "Transfer Settings" tab ....... 68
# List of Tables

Table 1: Number Notation ....................................................................................... 8  
Table 2: Font Conventions ...................................................................................... 8  
Table 3: Hardware Design ..................................................................................... 13  
Table 4: Legend to the View ETHERNET TCP/IP Fieldbus Controller .............. 15  
Table 5: Legend to the View ETHERNET TCP/IP Fieldbus Controller .............. 17  
Table 6: Legend to the View ETHERNET TCP/IP Fieldbus Controller .............. 19  
Table 7: Mode selector switch ............................................................................... 20  
Table 8: IP Address Structure ............................................................................... 29  
Table 9: Binary Encoding of Decimal Number 100 .............................................. 29  
Table 10: Digital input module 750-400 ............................................................... 40  
Table 11: Digital output module 750-501 ............................................................. 40  
Table 12: Visualization element 2 - configuration settings ................................... 59  
Table 13: Visualization element 3 - configuration settings ................................... 59  
Table 14: Visualization element 4 - configuration settings ................................... 60  
Table 15: Fieldbus protocols supported by the PLC ............................................. 69